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Abstract: - This paper describes an instrument that can compose a song using predicates of Ancient Greek 
Music. It employs the methodology and musical notation of this specific music system and at the same time, it 
provides a mapping mechanism that depicts the whole process to composition predicates of the usual notation 
of Western Music. The aim of this application is to facilitate the efforts of Ancient Greek Music researchers in 
getting closer to what Ancient Greek Music really was by parametrically performing melodic pieces.  
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1   Introduction 
“Ancient Greek culture was permeated with music. 
Probably no other people in history has made more 
frequent reference to music and musical activity in 
its literature and art. Yet the subject is practically 
ignored by nearly all who study that culture or teach 
about it. Sometimes its very existence seems to be 
barely acknowledged.” [1] 

It is true that we know very little about Ancient 
Greek Music (from this point and forth: AGM) 
primarily because we have no actual recordings or 
hearings and secondly because sources about 
Eastern Music, the successor of AGM, are scattered 
and not thoroughly indexed as is the case with its 
counterpart, Western Music. Furthermore, it is 
difficult for researchers with a profound musical 
education in Western Music and culture, well 
advanced in diatonicism and tempered scales to 
understand the chromatic  [2][3] and enharmonic 
background of AGM [1].  On the other hand, 
researchers and pioneers like West [1] and 
Pöhlmann [4] have managed to collect and organize 
a very large amount of documents and actual music 
scores and have given a scientific insight for a music  
system over 2000 years old.   

This project takes their work and tries to make a 
connection between that music and prevailing 
modern Western Music. A software instrument is 
produced, ARION, capable of reproducing whole 
songs both musicaly and vocaly and the same time 
the user can experiment with the various scales, 
symbols and frequencies having the total freedom to 
“imagine” and hear how AGM music really was. 
 
 

 
2 Problem Formulation 
2.1 The Challenge 
The challenge of the project is to be consistent to the 
source material and create an AGM composer with 
scientific accuracy and the same time to produce a 
synthesizing instrument with an easy to use interface 
targeting non-computer science experts. 

How can you faithfuly reproduce ancient music 
when you had never heard something like it *? The 
only safe way is to follow the work of experts in the 
field and the actual musical scores. But even these 
are usually incomple te. Also, there is little 
knowledge about the instruments used at the time 
and we are sure that they were very different than 
modern or even medieval ones. Moreover, the true 
Ancient Greek accent is different from the Modern 
Greek one and from the one used by foreigners 
today (the so called Erasmian) [5], so extended 
research had to be carried out on the vocal 
reproduction of the lyrics.  
 
2.2 The .NET Framework 
This project was built using Microsoft’s .NET 
Framework [6]. The framework is a set of libraries 
engineered specifically to enhance the development 
of Microsoft Windows oriented applications. It 
provides smooth interconnectivity to the underlying 
Application Programming Interface of the operating 
system and the means to manipulate each aspect of 
it. This application implements extensive use of the 
GDI+ calls that affect the Graphical User Interface 

                                                                 
* Having heard several CDs from bands all over the world 
claiming that they sing more or less AGM, we have concluded 
that they are strongly biased by their musical tradition rather 
than by   the AGM acquis. 



and provide us the ability to create our own controls 
or to extend pre-existing ones. The application also 
uses and XML table for storing the data of the 
Ancient Greek notes and their assocation to modern 
ones. 
 
 2.3 The Csound Music Language 
The sound of the instruments that his project 
performs was made with the use of Csound. Csound 
is a programming language designed and optimized 
for sound rendering and signal processing. The 
language consists of over 450 opcodes - the 
operational codes that the sound designer uses to 
build “instruments” or patches. Usually, two text 
files are created - an .orc (orchestra) file containing 
the “instruments”, and a .sco (score) file containing 
the “notes”. The Csound interpreter works by first 
translating the set of text-based instruments, found 
in the orchestra file , into a computer data-structure 
that is machine-resident. Then, it performs these 
user-defined instruments by interpreting the list of 
note events and parameter data that the program 
“reads” from: a text-based score file, a sequencer-
generated MIDI file, a real-time MIDI controller, 
real-time audio , or non-MIDI devices such as the 
ASCII keyboard and mouse. 

Depending on the speed of the used computer 
(and the complexity of the instruments in your 
orchestra file) the performance of this “score” can 
either be auditioned in real-time, or written directly 
into a file on your hard disk. This entire process is 
referred to as “sound rendering” as analogous to the 
process of “image rendering” in the world of 
computer graphics. 
 
2.4 Ancient Greek Music Sources 
Over 40 melodies, most of them fragmented, have 
survived as stone inscriptions or musical papyri 
(scraps of papyrus, the ancient equivalent of paper) 
containing musical notation. While it is certainly 
true that the hearings are lost recent research has 
satisfactorily deciphered AGM notation and rhythm.    

In fact, we know quite a lot: we know a great 
deal about the rhythms and the tempo of the music, 
since these are reflected in the metrical patterns of 
Greek verse [4]. Adequate knowledge has been 
gathered about the musical system, that is, how the 
scales were conceived and the like, since the works 
of several Greek musical theorists survive , like those 
of Aristoxenus †. Instead of using ratios, he divided 
the tetrachord into 30 parts, of which, in his diatonic 

                                                                 
† Aristoxenus, of Tarentum (Magna Graecia, - 4th century 
BC), a peripatetic philosopher, and writer on music and 
rhythm. 

syntonon, each tone has 12 parts, each semitone 6 
[7]. Some of the musical intervals that were used are 
even smaller than the space between two keys on 
our piano, a common feature of oriental scales. We 
can infer much about the instruments, using as 
evidence surviving fragments of ancient instruments 
[8][9][10], depictions on vases and wall paintings, 
literary descriptions, and cross-cultural comparison. 

In AGM scripts, above each line of Greek is 
notation that looks mostly like Greek letters, but is 
in fact vocal musical notation. Interestingly, ancient 
musicians had two completely separate systems of 
musical notation, the one meant for voice, and the 
other for instruments [1]. Some of these symbols can 
be seen in Fig. 1.  

 

3   The Application 
The application consists of three major surfaces: 
The Symbol Repertory surface, the Ancient Greek 
Music Surface and the Modern Greek Music 
Surface.  

The Symbol Repertory is the container of all 
AGM Symbols used by the application. It holds the 
Instrumental and the Vocal symbols. While 
browsing through the symbols the user can see as a 
tool tip the symbols frequency and the 
corresponding modern note.  

By right-clicking the Edit Ancient Note Dialog 
Box is invoked (Fig. 2). In that dialog box the user 
can modify the type of the note and the note’s 
frequency. The AGM Drawing Surface consists of 
three fields, Vocal Symbols, Instrumental Symbols 
and Lyrics. The user can either drag’n’drop a 

 
Fig. 1. Symbol Repertory.  Notes for instrumental 

and  vocal performance. 



symbol from the Symbol Repertory to the 
corresponding field or one can use the Text Tool 
(which is located in the Toolbar) to change each 
field (Fig. 3). 

The Modern Music Surface has two modes, the 
Vocal Mode and the Instrumental Mode (Fig. 4). 
The user can interact with only one mode at a time.  

By right-clicking on a note the Edit Modern Note 
Dialog Box is invoked where the user can modify 

the note’s duration and frequency shifting it from 
double flat to double sharp and in between (Fig. 5).  

Many notes of AGM have difficulty in their 
correspondence with their Western music 
counterparts. Especially in modes like Phrygian and 
Lydian, a creeping substrate for the development of 
oriental music systems can be detected. Since no 
accurate correspondence can be made, the 
instrument gives its users the flexibility to 
experiment by assigning different pitch levels, and 
therefore the fuzziness of scales can be resolved in a 
trial and error manner by hearing the note.   

The Toolbar of the application has six functions 
(Fig. 6). The first three (New, Open, Save) 
manipulate the music document. The other two 
(Select, Text) are used to drag’n’drop symbols from 
the Symbol Repertory to the AGM Surface (Select) 
or to change the text in the AGM Surface (Text).  

The last function is used for creating an audio 
representation of the current music document. By 
clicking it a Microsoft Wave file is created in the 
current working directory and the user can use an 
audio player to listen that file. The audio file is 
produced by using Csound’s rendering processes. 

Last but not least there is the MenuBar which has 
3 menus. The File menu deals with file handling as 
well as the document’s identity which contains 
information such as the date of creation of the 
document and the composer. The Tools menu has 
the Edit Association Table command and the Export 
to Wave command. The Association Table is the 
table from which the mapping function reads the 
data and maps AGM notes to Western Music notes. 
The last menu is the Help menu which at the 
moment contains only the credits for this 
application. 

 
 

 
Fig. 2.  Editing  an AGM note - the  Dialog Box.  

 

 
Fig. 3. AGM surfaces: notes for vocal and 

instrumental melodic scripting along with the 
lyrics. 

 

 
 

Fig. 6. Application’s Toolbar. 

 
Fig. 5. Altering AGM note’s pitch and duration. 

 
Fig. 4. Transcription to the usual Western 

Music surface. 
 



4   Usage 
The usage of the application is quite trivial. It works 
into two modes, the Vocal and the Instrumental 
mode. The user chooses the current mode by 
clicking on the desired Symbol Repertory page. 
When the application starts the default mode is 
Vocal mode. The user can add a note to the Ancient 
Greek Music Drawing Surface.  

Since Ancient Greek notes do not provide any 
information on their duration the user can simply 
change the duration by right-clicking on the modern 
note and choosing the desired duration in ?. When 
the composition is complete he can convert the 
composition to a Wave file and listen to it via his 
audio player of choice. 

 
5  Conclusions 
In recent years several efforts have been recorded in 
Greece and elsewhere in reconstructing AGM 
instruments, both physically and with physical 
modeling techniques [8][9]. The most notable was 
the reconstruction of the ancient hydraulis by the  
European Cultural Centre of Delphi in 1999. A wide 
range of other instruments has been also presented 
in exhibitions and live performances [10]. As 
prototypes for this restoration have been used 
fragments of AGM instruments found in excavations 
or descriptions of them in papyri.  

However, never before an electronic instrument 
has been presented that can be used as an editor, 
composer and synthesizer the same time.   

ARION is the first instrument of its kind. Its 
main advantage is that it provides researchers a user 
interface that alters scales, accents and pitch 
assignments helping them experiment with music 
forms and scales that have an inherent fuzziness.  
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